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I know I've said this before, but there is a lot going
on, and a lot of it within the last
month or so. First, the maintainers
of the various PCLinuxOS desktop
remasters are preparing for the
next round of quarterly releases of
updated ISOs of the Live CD.
Second, there has been a lot of
speculation about the future of
Mandriva, and PCLinuxOS is
starting to see a lot more users
taking another look at PCLinuxOS.
Face it. Linux users everywhere
are in pursuit of stability and want
to use something that has a more
stable, certain future.
Google continues to alter the range
of services they offer, ending the
files and pages features of Google
Groups, with no opportunity for
discussion or input from those who
utilize the features (just as they did previously with
Google Wave, after its short run). Xmarks, the very
popular browser add on that allows for
synchronization of bookmarks and open tabs across
multiple computers, is closing their doors and ending
their service, unable to find a business model that
works to provide them with sufficient funds to
continue operation with a free browser add on.
Speculation abounds about Xmarks future, ranging
from possibly making the Xmarks code open source,
to making Xmarks a pay service with a nominal
yearly fee.
But have no fear, good things are also happening
with The NEW PCLinuxOS Magazine. This month,

we continue our coverage of the LXDE desktop
environment. Andrew Strick
presents a duo of articles, with
LXDE: Get To Know Obconf and
LXDE: Configuring LXPanel. I
follow that up with my LXDE:
Adding Wallpapers, Panel
Decorations article. Meemaw
continues her series of articles on
the free OpenOffice Office Suite,
with her OpenOffice 3.2, Part 5:
Draw article.
Darrel Johnston reviews another
PCLinuxOS original, with his
Repo Spotlight: Know Your
System With Systeminfo article.
Gary Ratliff, Sr. continues
marching through the alphabet of
computer programming
languages, with his Computer
Languages A to Z: Pascal

article. Peter Kelly, coming off of his long and
popular Command Line Interface Intro series, gives
us some tips on how to best get assistance in the
PCLinuxOS forum, with his Getting Help In The
Forum article. Leiche reviews another recent and
new addition to the PCLinuxOS repository, with his
DeaDBeeF: A Lightweight Linux Audio Player
article.

I take a look at another Firefox addon in my Firefox
Addons: Rain or Shine, Forecastfox Tells All
article. DeBaas reports on his efforts to help sow the
seeds of Linux, in the PCLinuxOS Takes Center
Stage article. Patrick Horneker shows us how to
Read Barnes & Noble eBooks on PCLinuxOS,
and shares his parody of Joni Mitchell's Big Yellow
Taxi song, Big Linux Laptop.
We also have two new testimonials this month. We
also have our regular columnists, ms_meme and
georgetoon, back with more. Ms_meme shares a
couple of different, new Forum Foibles, as well as
two new songs. Georgetoon returns with another
Double Take, as well as another of Mark's Quick
Gimp Tips. This month's cover, celebrating fall,
comes from Timeth.
We hope you enjoy this issue of the magazine, and
that it gives you plenty to read until the next issue.
Until then, I wish each and every one of you peace,
tranquility, serenity and success.

Welcome From The Chief EditorWelcome From The Chief Editor

http://www.linpc.us
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by Andrew Strick (Stricktoo)

Introduction
Obconf is a GUI utility for configuring the Openbox
window manager. Many of its options are difficult, if
not impossible, to explain in words, and so the
reader is encouraged to “play at home,” as it were;
launch Obconf and play with each setting as it is
described.
Note: Both the LXDE and Openbox versions of
PCLinuxOS use the Openbox window manager.
This article uses LXDE, but most of the
discussion is applicable to both.

Launching Obconf
There are several ways to
launch Obconf. In the menu,
it is found under More
Applications >
Configuration > Openbox
Configuration Manager. In
the LXDE Control Center, it
is the Configure Openbox
option under the
Appearance Settings tab.
And it can be launched from
the console or run dialog
with the command obconf.

Fig. 01. The LXDE Control
Center.

The second option ("Configure Openbox") launches
Obconf.

Overview
Obconf has eight tabs. Each controls a specific
Openbox component: Theme; Appearance;
Windows; Move & Resize; Mouse; Desktops;
Margins; and Dock.

Theme
The Theme tab lists the available Openbox themes.
Each theme changes the way that Openbox looks.
On a default LXDE install the most obvious effects

are seen in the window decorations. The theme also
affects any on screen displays (such as the desktop
switcher) and the Openbox menu, if the user has
turned off the LXDE rightclick menu.
The Themes tab also has buttons for installing and
exporting Openbox themes.
“Install a new theme”: launches a file brower
window for navigating to the desired location. Once
there the user can select any .obt archive and
Openbox will install it.
"Create a theme archive (.obt)”: also launches a
file browser. The user can use this window to select
a directory containing an Openbox theme, and that
directory will be compressed into Openbox’s own
.obt archive format.
Note: I could not get either of these options to work.
Most themes downloaded from the internet come in
a more standard archive type (e.g. .tar.gz) and are
not seen by the install utility. And the creation utility
refuses to recognize any file or directory as an
Openbox theme. An easier method is to extract
themes from their archives and move them into the
~/.themes directory (which does not exist by default
and must be created by the user)

Appearance
There are three subsections to the the Appearance
tab.

Fig. 02. The Themes tab, with the Bear2 theme selected.
Notice that the window decorations change as soon as
the user selects a theme.

LXDE: Get To Know ObconfLXDE: Get To Know Obconf
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Fig. 03. The Appearance tab with default settings

Windows
“Windows retain border when undecorated”: if
the user launches an without any window
decorations, this option then allows the user to
decide whether that application window should still
have a border
“Animate iconify and restore”: when checked, the
act of minimizing an application to, or restoring it
from, the taskbar will show a simple visual. When
unchecked application windows essentially appear
or disappear when minimized or restored

Window Titles
By rearranging the listed options in the “Button
order” input box, the user can change the layout of
the window decoration’s buttons and title. The
default has the window icon (N) on the left edge, the
window title (L) in the middle, and the
minimize/iconify (I), maximize (M) and close (C)
buttons at the right edge.
Note: the Openbox theme determines the position of
the window title. Thus even if the window title (L) is
the first variable listed in the box, it will still display in
the middle of the window decoration, offset only by
buttons on the right edge. See Fig. 04 for an
example.

Fig. 04. The Appearance tab, with all the window
buttons added. Notice how the window title (L) remains
centered  despite being the first variable listed  and is
offset only by the other buttons

Fonts
This section contains options for setting various
system fonts.
“Active window title”: the font for the title of the
currently active window
“Inactive window title:”: the font for the title of any
currently inactive windows
“Menu header”: the font for the heading of the
Openbox menu
“Menu item”: the font for items in the Openbox
menu
“Onscreen display”: the font for any Openbox
notifications (such as the Information Dialog during a
window resize)
Note: “Menu header" and “Menu item" are not
generally necessary because the Openbox menu is
only used if the user enables the it in the PCManFM
settings.

Windows
Focusing Windows
“Focus new windows when they appear”: when
checked, any newly opened windows will come to
the foreground. When unchecked, newly opened
windows will remain inactive until the user selects
them (although they still appear on top of any
currently opened windows)

LXDE: Get To Know Obconf
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Fig. 05. The Windows tab
Placing Windows
“Place new windows under the mouse pointer”:
when checked, any newly opened windows will be
placed under the mouse pointer. This option does
not have a consistent orientation. That is, there is
not one specific part of the window that is always
aligned with the cursor; instead the window will align
itself to fit on the desktop while keep a portion under
the cursor.
“Center new windows when they are placed”: all
newly opened windows will be placed in the middle
of the desktop (unless they are maximized)
“Prefer to place new windows on: The active
monitor/The monitor with the mouse”: which
monitor new windows should appear on, if the
system has multiple monitors attached

Move & Resize

Fig. 06. The Move & Resize tab

Moving & Resizing Windows
“Update window contents while resizing”: when
checked the window contents will update to match
the new window size as it is being resized. When
unchecked the contents will remain static and will
only update to match the window once the resizing
has finished
“Drag threshold distance”: the number of pixels a
window must be resized before the new size is
displayed. For example: if this value is set to 85px, a
window will maintain its current size until the cursor
with the resize handle has moved 85px away. The
minimum value is 1. The maximum value is 100.

Fig. 07. Resizing the Obconf window with the "Update
window contents while resizing" option turned off.
Notice that the window contents remain at the previous
size, even though the window has been expanded.

“Amount of resistance against other windows”: a
window that is being moved will stop this distance
away from other windows and will not overlap them
unless the user continues to move the mouse. The
minimum value is 0. The maximum value is 100.
“Amount of resistance against screen edges”: a
window that is being moved will stop this distance
away from the edges of the screen and will not pass
them unless the user continues to move the mouse.
The minimum value is 0. The maximum value is 100.
“Switch desktops when moving a window past
the screen edge”: if checked, dragging a window
past the edge of the screen will move it to the next
virtual desktop

LXDE: Get To Know Obconf



7

“Amount of time to wait before switching”: the
length of time, in milliseconds, that a window can be
held past the edge of the screen without being
moved to the next desktop. The minimum value is
100. There is no discernible maximum.

Information Dialog
The information dialog is a small onscreen display
that shows the current size of a window while it
being resized.

Fig. 08. Information dialog
“Show information dialog: When resizing
terminal windows/Always/Never”: whether the
information dialog should always appear (when any
window is being resized), never appear or appear
only when the window being resized belongs to a
terminal
“Information dialog’s position: Centered on the
window/Above the window/Fixed position on the
screen”: controls the location of the information
dialog. If “Fixed position on the screen” is
selected, the user can set that location using the
“Fixed x position” and “Fixed y position”
controls.

Mouse

Fig. 09. The Mouse tab, with default settings

Focusing Windows
“Focus windows when the mouse pointer moves
over them”: simply placing the cursor over a
window will focus it; clicking is not necessary
“Move focus under the mouse when switching
desktops”: normally, when switching desktops, the
last window on the desktop to have the mouse focus
will have the mouse focus when you return to that
desktop. With this setting, the focus will default to
the window that is under the mouse cursor when you
change to the new desktop. If there is no window
beneath the mouse cursor on the new desktop (e.g.,

only your desktop background), then the last window
that had the mouse focus will retain the focus.
“Move focus under the mouse when the mouse
is not moving”: passing the cursor over a window
will not focus it; the cursor must pause on that
window to focus it
“Raise windows when the mouse pointer moves
over them”: moving the cursor over a window will
bring that window to the front, in addition to focusing
it
“Delay before focusing and raising windows”:
the delay, in milliseconds, before a window will be
focused and/or raised when the cursor passes over
it. The minimum value is 0. The maximum value is
10,000.

Title Bar
“Double click on the title bar: Maximizes the
window/Shades the window”: sets whether double
clicking on a title bar will maximize that window or
shade it
“Double click time”: the allowable delay, in
milliseconds, between clicks. The countdown begins
with the first click. For example: if the value is set to
4000, the action will occur if the user clicks the title
bar twice, and the second click is within 4000
milliseconds of the first. The minimum value is 0.
The maximum value is 10,000.

LXDE: Get To Know Obconf
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Desktops

Fig. 10. The Desktops tab

“Show a notification when switching desktops”:
when checked, a small notification will be shown
when switching desktops

Fig. 11. The desktopswitcher onscreen display
“Amount of time to show the notification for”: the
time, in milliseconds, in which the notification will be
displayed. The minimum value is 1. The maximum
value is 10,000

“Number of desktops”: the number of virtual
desktops employed by the user. The minimum value
is 1. The maximum value is 100
“Desktop names”: the user can rename a desktop
by double click on it within the list. This name will be
displayed on the notification when switching
desktops

Margins

Fig 12. The Margins tab

The Margins tab provides its own apt explanation:
“Desktop margins are reserved areas on the edge of
your screen. New windows will not be placed within
a margin, and maximized windows will not cover
them.”

Margins are useful if, for example, one wishes to
have a constantly horizontal conky instance along
the edge of the screen

Dock

Fig 13. The Dock tab
The dock is an area of the screen for certain stand
alone windows. For example, if the user eschews
the LXPanel in favor of another task manager and
system tray, those applications need a place on
which they can “anchor” themselves. That place is
the dock
Note: I cannot get the dock to function as
advertised. Consequently the above description
comes from my research and not firsthand
knowledge.

LXDE: Get To Know Obconf
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Conclusion
Openbox is an incredibly versatile window manager,
and it is impossible to catalogue all of the
possibilities. This overview is intended to get the
reader started; it is by no means exhaustive. The
best method of leaning is to get one’s hands dirty,
and the reader should do just that  fire up Obconf
and start tinkering with the settings. One never
knows what one might find!

Screenshot ShowcaseScreenshot Showcase

Posted by Ramchu, September 20, 2010, running KDE 4.

LXDE: Get To Know Obconf

http://www.enkiconsulting.net/
http://pclinuxos.com/?page_id=186
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by Paul Arnote (parnote)

Move over Microsoft. We don't need no
stinking "launch parties." It's time to be
shown how it's done right.
At least, that's how it was in The Hague,
Netherlands on September 18, 2010, at the
Digital Den Computer Club. Traditionally,
the club has pretty much restricted itself to
exclusively showcasing Microsoft products,
but PCLinuxOS user DeBaas has been
regularly showcasing the various flavors of
PCLinuxOS since 2007. The 50 or so
members of the club meet monthly to
discuss their computers and operating
systems.
Since he has began showcasing
PCLinuxOS, along with other popular
versions of Linux, he now has members
coming from Amsterdam, Leiden,
Maassluis, Vlaardingen and Hoek van

Holland. The goal is to spread the word
about Linux, and to show off its capabilities.
They meet to help one another with any
problems they may encounter, as well as
offer to install Linux (mostly as a dual boot
with Microsoft Windows) on all types of
computer hardware, from netbooks to
notebooks to desktop systems.
At the meeting on September 18, 2010, the
"Linux wall" of seven computers featured
PCLinuxOS, in one flavor or another, on
four of the computers. In the image, from
left to right, were computers running
Ubuntu, PCLinuxOS Gnome, PCLinuxOS
LXDE, PCLinuxOS 20107 (KDE 4),
PCLinuxOS Full Monty, Linux Mint KDE,
and Suse. Club member Chris Duijndam
took the photo after the meeting.

International CommunityPCLinuxOS Sites

Netherlands

Turkey

Denmark
Czechoslovakia

Italy

Poland

PCLinuxOS Takes Center StagePCLinuxOS Takes Center Stage

http://www.pclinuxos.nl/
http://www.bekozap.com/
http://www.pclinuxos.dk/news.php
http://www.pclinuxos.cz/
http://pclinuxos.it/
http://pclinuxos.org.pl/
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Answers on Page 29

Double Take & Mark's Quick Gimp TipDouble Take & Mark's Quick Gimp TipDouble Take & Mark's Quick Gimp TipDouble Take & Mark's Quick Gimp Tip

The Gimp, like all graphic applications, has
a wealth of tools for editing images. And
Gimp, like those big name apps, offers the
user many different ways to carry out the
same operation. For instance, in Gimp,
you can zoom in and zoom out in many
different ways. Using the keyboard, zoom
in by using Shift +. Zoom out by using the
minus key. You can also select
Zoom>View from the main menu. Or, you
can use a navigation tab in the right hand
dialog box. You can also use what I like to

Mark's Quick Gimp Tip
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call the QuickZoom tool
located the in the lower left
of the image pane. Simply
click on Quickzoom and
select your zoom level. You

can also select the zoom tool in the right
hand toolbox. With the magnifying glass
selected, simply drag it across any area of
the image to zoom right in. Zoom out by
holding down the the Ctrl key. Or, just left
click with the mouse to zoom in and, again,
to zoom out, hold down the Ctrl key and left
mouse click. Gimp gives you many
different ways to do the same thing.

Find at least seven differences between cartoons. ©2
010
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Mark Szorady is a nationally syndicated cartoonist with georgetoon.com. He blogs at georgetoon.com/blog. Email Mark at georgetoon@gmail.com.

TheQuickZoomtool in action.

http://www.georgetoon.com
mailto:georgetoon@gmail.com
http://www.gimp.org/
http://www.gimp.org/
http://www.georgetoon.com/blog
http://www.gimp.org/
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by Darrel Johnston (djohnston)

There is an excellent system tool for PCLinuxOS
users named systeminfo. It is a Zenity script written
by forum member Leiche. It encapsulates many
command line tools into one easy to use graphic

user interface. It can be launched from the
Monitoring section of the menu, or started from a
terminal with the command systeminfo. Once
launched, a warning window appears stating that
errors may occur.

Once you have pressed the OK button, the main
interface window appears.

To select an item to run, either double click the item
name or select the item and click the OK button. If
the item selected needs root privileges to run, you
will be prompted in a separate window for the root
password.

dmidecode needs root privileges to run, and shows
BIOS information.
lshw shows an extensive list of hardware interfaces
and devices associated with and connected to your
system. The output is shown in whatever web
browser you have chosen as your default. Some of
the other choices in the main systeminfo window are
included in the output of the lshw window.

lsusb (not shown) lists USB devices connected to
your system, as well as the USB interfaces.

Know Your System With SysteminfoKnow Your System With SysteminfoRepo SpotlightRepo Spotlight
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lsmod shows what kernel modules are loaded.

lsmod_search can be used to search for the
presence of a certain type of module.

dmesg shows the kernel messages (top, next
column).

lspci (not shown) shows PCI slot bus addresses and
any devices in the slots.
df shows the amount of disk space used for all
mounted drives.

mount (not shown) shows all currently mounted file
systems and their associated mount points.

iwconfig (not shown) displays information about your
wireless connection.

ifconfig displays information about your ethernet
connection.

xdpyinfo shows extensive information about your X
server configuration (top, next page).

Repo Spotlight: Know Your System With Systeminfo
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glxinfo shows extensive information about glx and
opengl associated with your graphics card.

Selecting fsck will run a file system check on all
connected devices after reboot. You are prompted to
save your current session by closing all programs
and saving all data. You can opt out by clicking the
No button in the Question window that appears.

top (not shown) will show all currently running
processes. fdisk will list all attached disk partitions,
and is the same as typing fdisk l in a terminal (top,
next column).

uname shows the running kernel name.

fstab (not shown) will display the contents of the file
/etc/fstab, which is a file executed when you boot.

Repo Spotlight: Know Your System With Systeminfo
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The fstab file instructs the system which partitions to
mount or not mount, what file system is on each
partition, and any security options associated with
each file system. The fstab file also contains options
to run a file system check before mounting a
partition.
groups (not shown) displays all group names.
group, shown below, shows the group names, the
group number, and any members of that group. The
"x" indicates that a password is required to access
the group or account.

menu_lst (not shown) displays the contents of the
file /boot/grub/menu.lst, which is the configuration
file for the GRUB boot menu.

sources_list (not shown) displays the contents of the
file /etc/apt/sources.list, which is the configuration
file for your Synaptic repositories.
whereis will find the location of a given file name.

Last, but not least, selecting Credits from the main
window will show who is responsible for this fine
piece of work.

Press the Cancel button in the main window to exit
the program.

Repo Spotlight: Know Your System With Systeminfo
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MP3 OGG

ms_meme's Nook: My PCLOS Prayerms_meme's Nook: My PCLOS Prayer
My prayer is to boot up with you at the end of the day

We will meet here on line

My prayer is a desktop in blue PCLOS array
You'll have yours I'll have mine

Tonight with the icons aglow
Oh tell me your password I'm longing to know

My prayer we will keep it alive just as long as we have
An external hard drive

Log on now be there
At the end of my prayer

http://pclosmag.com/html/Issues/201010/files/mypclosprayer.mp3
http://pclosmag.com/html/Issues/201010/files/mypclosprayer.ogg
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by Andrew Strick (Stricktoo)

Introduction
LXPanel is the default panel for the LXDE desktop
environment. Like the rest of LXDE, LXPanel is still
young (the currently PCLinuxOS version is 0.5.5,
though 0.5.6 was released in late July and will
hopefully soon reach the PCLinuxOS repos). Yet,
LXPanel delivers the essentials with plenty of
tweakability to spare.

Configuring LXPanel
LXPanel can technically be modified by editing the
underlying configuration file, located at~/.config/lxpanel/LXDE/panels. This
method is not advisable. The first line of the config
file gives ample warning:
# lxpanel «profile» config file.Manually editing is not recommended.# Use preference dialog in lxpanel toadjust config when you can.
Instead, LXPanel should be configured using the
builtin GUI tools, which are accessed by right
clicking anywhere on the panel and choosing Panel
Settings from the context menu.

2. Opening the Panel Settings dialog

A window with four sections (Geometry, Appearance,
Panel Applets and Advanced) will appear. Each will
be explained in turn.

3. The Geometry section

Geometry
The Geometry section governs the panel's
"footprint". Options in the Position column control
placement of the panel, while Size column settings
establish the dimensions of the panel.

Position
Edge: sets the screen edge on which the panel will
be displayed.
Alignment: determines where the panel will be
located on the edge: right, left or center (if the panel
displayed horizontally is on the top or bottom screen
edge), or top, bottom or center (if the panel is
displayed vertically on the right or left screen edges).
Margin: offsets the panel by the specified number of
pixels. A margin of 50 pixels ("50px") for the default
panel will create a 50px gap between the left screen
edge and the left end of the panel. However Margin
has no effect if the panel is centeraligned.

4. The panel, offset from the left screen edge by a 50
pixel margin

Size
Width: defines the width of the panel. The width can
be percentage of the screen, a specific pixel size or

LXDE: Configure LXPanelLXDE: Configure LXPanel

1. The default LXPanel
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dynamic (the panel automatically expands or
contracts to be just large enough to contain all of the
currently loaded applets).
Height: defines the height of the panel. The
minimum is 16px and the maximum is 200px. Items
on the panel do not scale to fit the new height of the
panel, and under 20px they get cut off.
Icon: defines the size of the icons on the panel. This
includes application launchers, the taskbar and the
system tray.

5. The panel at the maximum height (200px). Note how
the icons have spread across rows rather than scaling

Appearance
The Appearance tab, funnily enough, is home to the
options controlling the panel background.

Background
System theme: the background will be a solid color
from the GTK theme (specifically, the window color).

Solid color (with opacity): clicking on the small box
launches a dialog box the color panel may be fixed,
by defining the Hue, Saturation and Value levels or
the Red, Blue and Green levels, or manually
entering a hexadecimal color value (note: the value
is limited to six digits; LXPanel does not support an
alpha channel). The opacity of the panel can be
changed by either moving the slider or by manually
entering a value between 0 and 100.
Image: set a background pattern for the panel. The
default isusr/share/lxpanel/image/background.png,
but LXPanel will accept any PNG or JPEG image.
For best results, the image should be 1px wide and
the same height as the panel. When a different
image is selected the background updates
automatically, but application icons and the system

tray will still retain the old background, and will only
assume the new one when LXPanel is restarted
(e.g. at login).

8. The panel with a different background image
Font
Custom Color: changes the color of fonts of panel
plugins, such as the clock (the task bar will remain
unaffected). The dialog box is identical to that of
Solid Color (with opacity). If the box is unchecked,
the affected text will assume the color of menu items
as specified in the GTK theme.

Panel Applets
A note on terminology. The dialog itself refers to
panel components as both "plugins" and "applets".
For the sake of simplicity I will refer to them only as
"applets".

LXDE: Configure LXPanel

6. The Appearance section

7. The color picking dialog box
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9. The Panel Applets section
The Panel Applets tab controls which applets or
plugins are currently displayed on the panel, along
with their individual options. On the left, a two
column inset window displays the active applets, in
the order they appear on the panel (the top of the
left equates to the left of the panel).
Applets that are "streched" (spacers and the taskbar,
which have checkboxes in the righthand column)
will take up all available space on the panel. This is
not desirable for spacers, because they then waste

space, but it is necessary for the taskbar. If
unchecked, the taskbar will then consume the rest of
the panel, and running tasks will not shrink so as to
fit new tasks.

11. The unspaced taskbar consumes the entire right side
of the panel
On the right are five buttons used to control the
currently displayed applets. (Note: "currently
selected applet" refers to the applet selected in the
list in the Panel Applets window).
Add: launches a dialog box listing applets that can
be added to the panel.
Remove: removes the currently selected applet.
Edit: if the currently selected applet can be
configured, the Edit button will launch the
corresponding dialog box. If the Edit button is greyed
out, that applet does not have any configurable
options.
Up: moves the currently selected applet up in the list
(and left on the panel).
Down: moves the currently selected applet down in
the list (and right on the panel).

Advanced
Despite the title, the settings in the Advanced
section aren't really all that technical. Rather, it's
more of a catchall for options that did not fit
anywhere else.

Set Preferred Applications
File Manager: the file manager that LXPanel will
use to open directories. By default it is set to
PCManFM, but can be changed to the user's desired
file manager, such as Thunar. However this change
will not affect an application launcher in the
Application Launch Bar.
Terminal Emulator: the terminal emulator used by
LXPanel. The default is LXTerminal, but it can be set

LXDE: Configure LXPanel

10. A diagram of the default applets and placement

12. Configuration settings for the clock
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to the user's prefered emulator (e.g. mrxvt). Again,
this will not affect an application launcher.

Properties
Make window managers treat the panel as a dock:
when checked window managers will see the panel
as a dock and not a window. It will not be displayed
on a list of open windows (e.g. the Alt+Tab window
switcher) or the pager.
Reserve space, not covered by maximized windows:
maximized windows will abut the panel instead of
covering it.

Automatic Hiding
Minimize panel when not in use: hides the panel
unless the mouse hovers over it
Size when minimized: unlike other desktop
environments, which completely hide the panel until
the mouse touches, say, a certain screen edge,
some piece of the panel is always in view, even
when hidden.The minimum is 2 pixels, and the
maximum is 10.

14. The very small darkblue line is the visible portion of
the (mostly) hidden panel

Conclusion
LXPanel is fairly robust despite being both
lightweight and young. Even with this early release
there are plenty of goodies and lots of room for
customization. As LXDE matures LXPanel will also
evolve, and doubtless become even more full
featured.

LXDE: Configure LXPanel

It's easier than

E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

13. The Advanced section
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by Peter Kelly (critter)

When you start out with Linux, you will almost
certainly encounter some problems. Not that Linux is
difficult to use; it isn't. It is different, just as any
unfamiliar software is different.
If you came to Linux from Microsoft Windows or
even a Mac system, then you may remember your
first few weeks when you wanted to hurl your
'stupid' computer through the window. The problem
though wasn't the computer, it was you, or rather
your lack of experience with the software that was
running on the computer.
Working with Linux is the same. When you first
experience a hairtearing problem, you'll blame
Linux. You won't blame the computer this time
because it was all working just fine before you put
that 'stupid' Linux on it. Sound familiar?
Fortunately, help is at hand and one of the best
sources of help is the PCLinuxOS forum. The folks
who frequent the forum are some of the friendliest
you will find anywhere, and with their help you can
usually solve most Linux related problems.
Ask your question and rest assured that nobody will
laugh and snigger or think that you are stupid.
Everybody on the forum has experienced the same
rite of passage.
Before you do start posting, there are a couple of
things to do.
1. Register. This isn't compulsory but it does mark
you as part of the community and gives members a

point of contact in the form of personal messages,
should they need to pass information to you. You
might also consider introducing yourself in the
Welcome Center section.
2. Read any usage rules in the sections and
subsections. You may also want to read the stickied
post, entitled How To Ask Questions The Smart Way.
This post is a very well written guide to help new
users get the answers they need in the shortest
amount of time possible.
That's it.
When you've scratched your head over your
problem for long enough and Google isn't being any
help, then head over to the forum. I've provided a
link above.
Most of the questions asked by new users have
already been asked by other new users and duly
answered, so the first thing to do is search.
Click the home button on the menu bar. This will
make sure that you are not in any subsection, so
that your search will be in the whole of the forum.
Next, in the search box at the top right, (the one with
the little magnifying glass next to it), type in your
query or try using the search button on the menu bar
 2nd over from the home button. This will give you
more options, such as in which subsection to
search.

What you type in here is taken literally, so if you type
in something like "screen looks wrong" then that is
what will be searched for. If nobody else has typed
that, then your results will be disappointing. Instead,
your query should be more specific and include the
name of the hardware or software component that is
causing you difficulty. "Nvidia 8500GT set at wrong
resolution" would yield better results. I'll show you
later how to gather this relevant information.
Your search is on the phrase you type into the box
within quotation marks, and the results are sorted
with the most relevant result at the top.
If the entry has the word 'solved' in the title, then this
would be worth looking at. In any case, read the first
few results until you find what it is that you are
looking for. If you don't find it, then it should be pretty
obvious that you are heading down a blind alley.
Try rephrasing the search term and see if that brings
better results. Often, the results from the first search
will give you a clue as to what to add or remove from
the search term.
When you can find no satisfactory answer from
previous posts, then it is time to ask the members.
As you are looking for help, try to post your question
in the most relevant subsection of the help section.
Members with expertise of those particular subjects
visit them regularly. If you can't decide in which sub
section to post, have a look in each of them to see if
the types of questions being asked are similar to the
problem that you are experiencing.
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If you do post your question in what turns out to be
the wrong place, then often a moderator will move it
for you.
The title of your post is as critical as the search term.
You'll want to phrase it to try to catch the attention of
somebody who has experience in the area of your
problem and to reflect the type of problem that you
are having.
If you get no replies, don't think that you are being
ignored. Have another look at the title of your post.
Does it read as a request for help? Does it correctly
show the essence of the problem? Try rephrasing it
slightly. Remember that the person that may be be
most suited to help you may be in a completely
different time zone and may be at work or asleep.
The main body of the text should describe your
problem accurately. If you have received an error
message, then repeat its content as closely as you
can remember it. "I got an error that said something
about..." is not very helpful. What was the
something?
Try to include as much information as possible. The
people that you are asking to help you don't have
the benefit of seeing the problem on your machine.
There is a lot of information that you can provide that
will enable more people to help you more quickly,
such as your hardware specifications and the
Desktop Environment. (Is it KDE4, LXDE or
another?) These facts can be displayed in your
signature if you have registered.

Example:
Motherboard ASUS M2AVM Phoenix BIOS**
Hard Drives 2 x Maxtor STM350032 500GB SATA
Memory 4 x 1GB DIMM 800 MHz
Processor AMD Athlon 64 X2 4800+
Video nVidia GeForce 8500 GT
Sound Creative Soundblaster CA0106
PCLinuxOS 2010 KDE 4.4.5
The above is sufficient to give people an idea of the
hardware that you are working on.
Once you have made your post, you may be asked
for other information that baffles you. This is how to
get that information. Don't try and remember too
much of this, but use it as a reference when you
need the information.

Software problems

If your problem is software related, and I don't mean
the operating system, but an application that is not
doing what you want.
Apart from the description of what you experienced
here, the most important information you can give is
the software version number. To get this, click on the
Help button and then on the option that usually
reads 'About Application'. Of course applicatiowill
actually be the name of the application.
If this fails, then open Synaptic, the package
manager, which is what you use to upgrade your
system or to add and remove software. There is
usually a shortcut icon to this on your panel or in
the drop down menu that appears when you click
the menu button on the extreme left of the panel. If
you can't find it, then hold down the Alt key and
press the F2 key (if you are running KDE 4; other
desktop environments may use a different keyboard
shortcut). In the box that appears, start typing the
name synaptic, then click on the icon when it
appears below.

With the application opened, select Search from the
menu, and type in the name of the application that
you want the version number of. Click on
'Description and Name' and from the displayed list
select 'name'. Click search.

Getting Help In the Forum
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In the results, anything with the little square on the
left, coloured in green, is installed on your system.
The installed version is the number that you need.

If the application is to be executed from the
command line, (and if you don't understand this, you
can safely skip this bit) then follow the command
name with a space, then enter
v
version
or help
will usually get the information that you need. Please
don't do anything on the command line as the root
(administrative user) unless asked to so by a more
experienced user.
As all applications are different, that is about all the
information that you can supply in the first instance.
When somebody responds, you may be asked for
more or different information. If you don't understand
what they want, then ask politely for clarification.
There are many people on the forum from many
different backgrounds, and your language may not
be their first language.

Hardware problems
Hardware problems are rarely actual hardware
problems, but difficulties in interfacing the hardware
with the operating system. This used to be a real
deal breaker for Linux, but nowadays most hardware
works just fine, and the situation is improving rapidly.
There is a lot of hardware available, so identifying it
as accurately as possible is vital. The drivers
required for last year's model may be alien to this
year's model. You may have a real hardware
problem, such as a hard drive nearing the end of its
life, and accurately supplying the make and model
number may trigger a response from somebody who
has experienced this.
Where do you find this information?
The first and easiest step is to look at it. If it is an
external piece of hardware, such as a printer or
scanner, then pick it up and have a look around it.
Write down anything that might be relevant. You may
even be able to use this information to get a solution
from the manufacturers website. If the hardware is
internal, then look at the documentation that came
with it or look on the case or ask the store that sold it
to you.
PCLinuxOS has its very own builtin hardware
detective. You'll find it in the PCLinuxOS Control
Center, otherwise known as PCC, by clicking on this
icon on the panel

or in the menu under more applications then
configuration then configure your computer. (Not

configure your desktop, that's something different). If
you still can't find it, press Alt + F2 and type in pcc in
the run box. That should find it for you. If it doesn't,
then type in harddrake.
You will be asked to supply the root (administrative)
password. You will have a lot of control in here and
could damage your installation. But as we are only
querying, and not changing things, you should be
fine. Most common system settings can be altered
here, so by all means, have a look around but don't
touch.
Click on hardware then click on browse and
configure hardware. This will interrogate your system
and provide a lot of information about all manner of
things, probably some that you didn't even realise
you had. Note that if you had to type harddrake
above, then you will already be at this screen. PCC
is a sort of graphical menu for lots of things with the
word drake in them.
If you want information about, say a hard drive, then
click the triangle next to 'Hard Disk' in the left hand
panel, then click on one of the drives. The right hand
panel will show lots of information about that drive
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including make and model and what partitions it
contains. You may need to use the scroll bar on the
right to see all of the information.
There are dozens of utilities available in Linux for
getting information about your hardware, but many
of them are command line based. This usually
scares the bejeebers out of new users. So it is
fortunate that there is a graphical solution to this
available to PCLinuxOS users called systeminfo.
It was written by forum member and magazine
contributor Leiche. Systeminfo will provide most of
the information that you, or anybody, will ever need.
If not installed by default in your version of
PCLinuxOS, you can install it using Synaptic. Some
system critical information will require the
administrative password to be able to view it, but
you will not be allowed to change anything. This
makes it ideal for new users who need to provide
this type of information.
If that is not enough information, then there are also
a couple of tools named hardinfo and hwinfo which
you will probably have to install using Synaptic. The
first one, hardinfo, is graphical and can be used in
the same manner as any of the other tools that we
have discussed. However hwinfo is command line
only and produces vast amounts of information
about your system (no personal details). If you have
to use this, then I would suggest sending the
information to who ever needs it as a file, maybe in a
personal message.
To do this is simple, but you need to open a terminal
which you will usually find in more applications then
terminals. Select a basic terminal, not a root
terminal.

Which terminal you choose doesn't matter, but avoid
Yakuake, for now, if it is offered. Once you have
installed hwinfo and have a terminal open, you are
good to go.
You will have in front of you an almost blank screen
with the cursor blinking at you. This is known as the
prompt.
Type in the following line exactly. You don't have to
understand it yet.
hwinfo > ~/hwinfo.txt
That will place a plain text file named hwinfo.txt into
your home directory. Open your file manager,
Dolphin, Konqueror or whatever, and you should see
the file. Open it in a text editor such as kwrite and
you will see the output. If you understand all of it,
then you have a very bright future in Linux.
You can use the above method to capture the output
of any command by simply substituting the name of
the command from hwinfo to the new command,
then changing the name of the captured output file
from hwinfo.txt to something more appropriate.
Some commands will not run as an ordinary user
and you will need to gain administrative permissions.
In this case do the following.
Open a terminal, and when you see the prompt, type
cd and press enter. This will place you automatically
in your home directory.
Type su and press enter. You will be prompted for
the administrative password. Enter it. Nothing will
appear on the screen as you type. This is normal.

Press enter and the $ in the prompt will change to a
#. Probably the whole prompt will turn red to remind
you that you now have administrative powers, and
that you should be extremely careful about what you
type. When you have administrative powers, as now,
remember this golden rule.
If you are unsure that what you are about to do is
what you should be doing: Don't do it!
When you have doubts like these while in a terminal
emulator such as konsole, with administrative power,
use the mouse and the left button to drag  select
the text that you are about to execute, or even the
entire screen of text that is visible, and press and
hold both the control key and the shift key. Then
press c to copy the text. Copy this into a reply to
your helper (control v achieves this), followed by an
"Is this correct?" plea. Then wait for a reply.
Only when you are both happy that this is what you
want, should you press return. Time doesn't matter.
As long as you are logged in and the computer is on,
your terminal session will wait for your confirmation,
even if this is a matter of days!
Examine it carefully for errors and only press enter
when you are satisfied that it is correct.
Hold down the control key and press d. This will
leave the terminal open but return you to the safer
normal user role.
There are many more tools we could discuss, and
you may be asked to use some of them by
respondents to your questions. Take guidance from
them to ensure that you supply the correct
information.
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Other information
You may well be asked for information that the
hardware interrogating utilities cannot provide.
Usually, this is the content of system configuration
files, and you may not have permission as a normal
user to access them. You may also not know how to
find them.
One of the files often asked for is your grub boot
menu file, which is a file named menu.lst and is kept
in the /boot/grub directory or folder. In linuxspeak it
is known as /boot/grub/menu.lst. When this file gets
corrupted, you may not be able to boot into the
system normally.
To get this information into a reply, do the following:
(Note: This procedure is the same as for capturing
the output of a command but is so important that I
will repeat it here).
Open a terminal, and when you see the prompt, type
cd and press enter. This will place you automatically
in your home directory.
Type su and press enter. You will be prompted for
the administrative password. Enter it. Nothing will
appear on the screen as you type. This is normal.
Press enter and the $ in the prompt will change to a
#. Probably the whole prompt will turn red to remind
you that you now have administrative powers, and
that you should be extremely careful about what you
type.

Type this in exactly as shown below:
cat /boot/grub/menu.lst > ./menu.lst.txt
Examine it carefully for errors, don't miss the period
before the slash in the second part, and when you
are satisfied that it is correct press enter. You can do
no damage with this line of text  the worst that can
happen is that it doesn't work.
Hold down the control key and press d. This will
leave the terminal open but return you to the safer
normal user role.
You now have a plain text file in your home directory
named menu.lst.txt that you can copy and paste into
your reply. This is also a useful backup should the
original file go bad.
Some files will allow you to do this without using the
su command, but this method will work for all.
For any other file, you can repeat the above just
changing /boot/grub/menu.lst for the required file,
and ./menu.lst.txt for whatever you want your copy
to be named.
Here's a few of the most commonly requested files
that you can use to copy and paste into your
information queries:
~/.bashrc
/boot/grub/menu.lst
/etc/fstab
/etc/mtab
/etc/hosts
/etc/sudoers
/etc/modprobe.preload

/etc/printcap
/etc/X11/xorg.conf
/etc/sysconfig/network
And a few of the most common utilities that you will
be asked to provide output from:
alias
env
df
du
fdisk l
free
hostname
ifconfig
ls l ~
ping {ip address}
ps aux
top
uname a
These are very brief lists, but are some of the items
that you may be asked to supply information
from/about.

Responding to a reply
When you get a response to a cry for help, read the
reply very carefully.
1. Have they understood your problem?

2. Are they requesting more information or clarity
over the problem?
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3. Have they suggested a course of action that you
don't fully understand?

4. Has the problem been resolved (fully or partially)?
If the answer to any of these questions is anything
but number 4, then go back through my suggestions
and try to get a resolution.
If the answer is that you have a satisfactory solution,
please thank the people that have helped you and
mark the thread as (solved) to assist people looking
for an answer to a similar problem. You mark your
thread as solved by going back to your original post
and editing the topic title to include the word "solved"
in it (or added to it). This helps others who may
come along later with a similar problem find the
solution for their problem.

Conclusion
These steps should, hopefully, assist you in getting
an answer to most of your queries.
Please bear in mind, though, that not every problem
has an easy or obvious solution.
One of PCLinuxos' most respected and capable
members, OldPolack, has a scanner that just will
not work under Linux due to the lack of Linux driver
support by the manufacturers. He has found a work
around to this through a version of Windows running
as a 'virtual machine'.
If he can't get it to work, then just look for a kludge
like this or replace the hardware. There's no sense

in banging your head against the wall. Fortunately,
situations like this are becoming steadily rarer.
Whatever your experience is in seeking help on the
forums, I hope that you can remain patient and polite
and, if you are helped, thank the people involved.

If you like the forum, don't forget to visit the
Sandbox. Here you can meet other members and
discuss all manner of things, Linux related or not.
The general idea here is to have fun and relax.
Go enjoy!

Screenshot ShowcaseScreenshot Showcase

Posted by coffeetime, September 29, 2010, running e17.
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by Meemaw
We can do word processing documents and
spreadsheets now. We've even gotten proficient at
presentations... well, at least I have, and I hope you
have as well. The next part of OpenOffice to explore
is Draw. OpenOffice.org's website says:
“Draw anything from a quick sketch to a complex
plan. Draw gives you the tools to communicate with
graphics and diagrams. Manipulate objects, rotate in
two or three dimensions; use sophisticated
rendering to create photorealistic images. Smart
connectors make short work of flowcharts,
organisation charts, network diagrams, etc.”
As before, I'm no expert, but this summary can get
you started.
Notice when you open Draw, the appearance is
similar to Writer, and also to Impress because it has
a pane at left showing your pages. You can right
click in the pane to add pages, and even add a page
between two existing pages, just as you can do with
Impress. The top toolbar is similar to Writer, with
Open, Save, Print and so on, being in the same
places. The toolbar below it is different depending on
what you are doing. The text formatting items are
right there IF you have chosen to add text to your
drawing. When you are adding graphics, the toolbar
has Line and Fill so you can alter the border and
color of your graphic. The toolbar that is at the
bottom is where all your drawing tools are located.
From there you can insert rectangles, circles, lines,
arrows, speech boxes (called 'callouts') and various
other shapes. With the
tools there, you can do
some interesting things.

Notice that to the right of many of these tools, you
can see a down arrow... meaning there are many
variations of that particular tool. If you click on it you
get a popup showing all the designs included.

This set is called Symbol Shapes. You can put any
shape from this box, or any other. The box on its left
is Basic Shapes. The box to its right is Arrows of all
sizes and designs, and then moving to the right, we
have shapes for Flowcharts followed by Callouts
and Stars.
At the right end of the toolbar, you will see a few
tools that help you manipulate your drawing. For
example, you can use any of the tools from the
Align box below to center your object or align two
objects just the way you want them. To its left is the
Effects tool, and at the right of the Align tool is the
Arrange tool and the Extrusion tool.

Opening a blank drawing, you can add a rectangle
or anything else you desire. The default is to make
the boundary of each item black and fill it with blue,
but if you go to the second row of tools at the top of
your window you can change the fill to another color
and the boundary (line) to something else as well.
You can also set the fill to 'none', which will take all
the color out of your object and leave just the
outline. You could leave the color and change the
line to invisible, or make it thicker or dotted. The
dropdown shown changes the style of the line and
the one to the right of it sets the line thickness. My
outline is black as you can see, but the next
dropdown allows you to change the line color or
make it invisible.

The dropdowns for fill are as follows:
The one that says Color (above) gives you the
option to fill your object with Color, a Gradient,
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Hatching, a Bitmap, or for the fill to be invisible.
The one that says Violet (above) gives you the
option different choices for the fill type you selected.
In the examples below (left to right), the fill is the
color violet, a blue to white gradient, blue
crosshatches, and a rose bitmap.

Sometimes you want to use a certain effect on your
object. I wanted to make sign that had a rose
background and a rectangle in front that was
partially transparent. The first rectangle I placed was
filled with the rose bitmap, and the second one I
added was filled with a light grey. Choosing one of
the objects, then going to 'Format' > 'Area' gives
you a window that contains several tabs (Area,
Shadow, Transparency, Colors,
Gradients, Hatching and Bitmaps.)
Notice the last four are the same as in
the dropdown we looked at earlier.... of
course this is the alternate way to edit
your object. It is an even more detailed
editing box. The Transparency tab is
what you use to set the fill from visible to
almost completely transparent. I set the
roses at 25% and the grey box at 45%
(remember, the higher number makes it
more transparent.). Now you can see
the grey box (and I could put text on it),
but you can see the roses through it.

On most versions of OODraw, the tool next to the fill
color is Shadow. You can put a drop shadow on
most of your objects. On the screenshot below, you
will see a shadow to the right and below the object
on the left. In the Format > Area box you can select
the Shadow tab and set the direction, color,
transparency and extent of your shadow. In the
example, the shadow is down and right, color is a
shade of grey, no transparency, and it is about 0.10"
from the original object.

Notice the yellow dot on some of your shapes? They
will allow you to make changes to those shapes. You
can draw a rectangle with rounded corners and if
you grab the dot and move it, you can change the
amount of curve on the corners far enough to even

have an ellipse
instead of a
rectangle!!! On
the shot below,
the shape is a
ring, but the
'grabber' can
make it thin or
thick.

If you draw a star, the grabber will let you adjust the
points on the star so they are shallow or deep. On
the stars below I started with the 8point star on the
left. The star on the right was made by grabbing the
yellow dot and moving it toward the center of the
star, which pulls the 'inside corners' of the points
inward.

I haven't covered some of the other tools: From
extreme left to right on the bottom toolbar is the
Selection Tool (you will do you resizing and moving
with this), Line (only straight lines), Arrow (only the
one arrow), Rectangle (rectangles with no
variation), Ellipse (ellipses and circles with no
variation) and the Text Tool, which you will use for
all text. After that, the special groups of tools start
with the Line Tool (straight lines and freehand lines
are here), Connector Tool (for constructing
flowcharts or connecting two gluepoints) and Arrow
Tool (with an assortment of arrows including a
dimension tool, which draws a double headed arrow
and gives you a measurement as well.)

Another tool that I
should mention is the 3D
tool in the top toolbar (it
may not show by default,
but you can choose it by
editing your toolbar.) In
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the screenshot I have circled the 3D tool. With a little
messing around you can convert some of your two
dimensional objects to 3D ones. The tools can
change the depth of your object, how round you
make the edges and even the direction of the light.

As with other drawing
programs, you can
layer objects to make
other designs. I made a
gradient background,
with two rounded
rectangles. The bottom
rectangle was a border
and shadow, and the
the top one was a semi
transparent gray
rectangle with no
border. Then I added
Dobie on top of the
other layers:

I experimented with another tool I found called an
Image Map. From OpenOffice Draw's Help section:
"An ImageMap is a referencesensitive graphic or
text frame. You can click on defined areas of the
graphic or text frame to go to a target (URL), which
is linked with the area. The reference areas, along
with the linked URLs and corresponding text
displayed when resting the mouse pointer on these
areas, are defined in the ImageMap Editor. The
Image Map Editor allows you to attach URLs to
specific areas, called hotspots, on a graphic or a
group of graphics. An image map is a group of one
or more hotspots."
You can insert a graphic, then go to Edit> Image
Map. You will get another window with your graphic
in it. You can then draw a simple shape over your
graphic (I used an ellipse), and assign a
web address to it. You can even add text

that will show
when you pass
your mouse
over it, and
when you click
on it, you are
taken to the
assigned web
address.
Since my
graphic was
Dobie, you
should know
which website
I used and my
text shows at
right!!!

Make sure you click the "Apply" checkmark before
you close the editing window.
It can be saved in html format to be used on a
website.
I haven't covered everything, but I hope you know
more now than you did before. It was fun exploring
OO Draw! With a little practice, I'm sure you can
make something wonderful! Enjoy!
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Answers to Mark Szorady's Double Take:
(1) Bowl different; (2) Bat smaller; (3) Hair
shorter in back; (4) Teeth missing; (5) Forehead
crack different; (6) “The” changed to “my”;
(7) Sleeve button missing
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Want To Help?Want To Help?
Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!
You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.
Join us on our Google Group mailing list.

In last months Forum Foibles
I featured names of users
All of them were really neat
And most of them were doozers
The topic was a popular one
It was read through and through
Since then more folks have come forth
So here is User Names Part 2

ms_meme
I had run across the Village of Osmar while
researching my name, They have a winery there,
and I would love to get some to try, and really just to
have the labels. One of these days, when I have
money. Anyone know the winning lottery numbers?
My mother had traced it (the name) to Belgrade
Serbia, but all records before that were lost (wars
and such). It is also possible that it is of German
decent. Interesting, but irrelevant. I am just another
American Mutt. pcosmar
I'm nearly 39 years old and still skateboard. Mostly
longboards, downhill carving and flatland 'pumping'.
Anyway the email address "oldmanskates at
gmail.com" shortened to "omskates". I'm glad to be
here with you guys. omskates
"malspa"
M.A.L.'s Pa.
I'm M.A.L.'s dad, and that's the most important thing
I am. malspa

Schtufbox is the name I make music under, can't
remember why it popped into my head. I also go by
the names Asharin and Zacharin in online games.
Asharin because it sounded apt for a half elf in
neverwinter nights...and it just stuck, Zacharin..well it
rhymes with Asharin. schtufbox
My nickname is my first name Robert shortened to
Rob, then add birthday month and day. So rob0917.
Well the Pendragon part goes back to CB radio.
Here in the UK, CB radio was illegal for a long time.
Even today, the type used in the US still is. So back
in the late 70 early 80's, if you used a CB, you were
breaking the law. Strangely, you could buy one, own
one, but using it would get you in trouble. Because
of this, no one used there real names or talked in
plain English. It was all codes and such. Most of the
code came from the US. So as a 17 year old in his
old Ford Escort, whippy aerials and all I had to come
up with a name for myself, a handle. Due to my
Cornish heritage, I came up with Pendragon!
My nick is not related to any linux distro... slax
I couldn't come up with anything that sounded classy
or very original and everyone I have worked with has
either called me a beast or animal because of my
work pace so I picked one of those. Besides, I really
dig Animal from the muppets.. animal
My first and last name scrunched up. Plus it sounds
like something out of a Louis L'Amour book. Joble
It is my Amateur Radio call sign. Amateur Radio
license is issued by the Federal Communications
Commission. The call signs issued by the FCC are
in alphabetical order. I will use my call sign as an

example. There is K, KA, KB, KC and so on. That is
for the first part of the call sign. Now for the second
part of the call sign, YHD. There is AAA, AAB, AAC,
ABA, ABC and so on. Now for the region code, the
"9" in my call sign shows which region I am in. The
United States is divided into 9 different regions.
ka9yhd
meme was the name of a make believe childhood
friend. I still like make believe stuff. And I suppose
we all do a bit of made up stuff here.
When I joined the forum I needed a user name
Something not too wild something not too tame
Wanted you to see me and never ever miss me
That's why I made my user name ms_meme

Forum Foibles: Forum User Names, Part 2Forum Foibles: Forum User Names, Part 2

http://groups.google.com/group/pclinuxos-magazine
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by longtom
Some of you might have been aware that a new,
young member has joined us. It's my sidekick – no,
not Robin – longtom jr.
Junior is 12 years old, my youngest son and has
been interested in technical matters from a very
early age. If you imagined you would walk through
our house with a screwdriver in your hand without
being noticed by Junior you are – wrong. He will
attach himself to you and he will stay there, your
shadow. The difference to a shadow, though, is the
soundtrack:
“Where are you going? What
are you doing? Why are you
doing this? How does that
work? Why does it work that
way and not different? Can I
do this as well? Why can a
four year old not install lights to
the ceiling or work an electric
planer or do this wonderful
stuff with a table saw or ….?”
You get the drift. He is just
there, relentless. So you either
get worked up or you know all
the answers. I tell you what, I
don't know all the answers but
he keeps me on my toes – which is wonderful.
Since February last year I am dabbling with Linux.
Needless to say, from my very first borked Ubuntu
install he was at my side, through thick and thin, for
better and for worse – chattering away, asking
questions I haven't even thought of, never mind that

I could answer. So we learnt, so we went on, trying
distros, reinstalling, hacking code we barely
understood, copying and pasting bash we hoped
would improve – well – something. And all the time
he was there, stealing with his eyes and asking and
chattering away.
He also followed what was happening in the forums I
was attending at the time. However, I soon found
that some forums were not quite suitable for 11 or 12
year old boys, even though they were, in effect,
technical forums. The tone and way people would
treat each other was not something I would have

liked being associated with
Linux. I also didn't want him to
think these are the kind of
people his dad likes to hang
around with. Well, I don't, but in
most of these places you have
to take the good with the bad,
and anything really bad gets
excused by some or other
“human rights” or a gross
misinterpretation of the
freedom of speech. So I didn't
do much forum stuff with him
present at all.
Since February this year I am
with PCLinuxOS (oh – just stop
the groaning, will ya) and

checking out the forums and loving it. Junior could
sit next to me while I interacted with it, could sit next
to me while being on the IRC channels and enjoy
(and giggle away at) all that was going on there.
So some days ago, I opened his very first forum
account at the PCLinuxOS Forum. It was an event of

some magnitude, I might tell you, which stirred quite
a bit of excitement. He won't be here too often since
the life of a 12 year boy in our quarters means a lot
of nonPC activity and his computer time available
for after our surfing is regulated, but he'll be around.
The reason I am waffling on about all this is to thank
all members of the community who gave him such a
great welcome. He loves the attention and has even
made his first steps in asking for help, even though
his English is not as fluent. He doesn't have admin
rights yet, but he is learning python and bash script
when he feels like it, and it'll take probably only a
little time until he tells me how this all works. I can't
wait for it; he'll be a great teacher! (I hope …)
So, thank you all for the welcome of our possibly
youngest member, and thank you for this
environment where I can let him roam around with
impunity.
Oh – and should you need some help with scripting
– don't ask me.

Testimonial: My SidekickTestimonial: My Sidekick

http://pclinuxos.com/?page_id=7
http://www.distrowatch.com
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by Daniel MeißWilhelm (Leiche)

Another audio player? Yes indeed, but a lightweight
player with support for many audio file types.
I use DeaDBeeF on
PCLinuxOSLXDE, and it's
a great addon for it. It is
available in the PCLinuxOS
repository, and is only 2,637
KB in size. Seamless and
light, it allows me to
configure my own hotkeys,
which works great.
DeaDBeeF is built using
Gtk+ 2.0 libraries, and
requires no KDE or Gnome
dependencies to be
installed. It also supports
many features you expect to
find in a modern audio
player, including ID3 tags
(various versions), a draganddrop interface,
playback control from the command line, gapless
playback, and radio and podcast support. You can
go to the DeaDBeeF web site to view a full list of
features.

I can even set the volume
louder with the use of a
hotkey, defined as "Super"
(a.k.a. the "Windows"
key"), and the "+" or "plus"
key. To set the hotkeys,
open Global Hotkeys
under the Edit >
Preferences menu. Click
on the Add button, double
click on the entry, and
select the action you want.
To set the key
combination, click on the section to highlight it, and
double click under the "Key combination" column.

Now, simply press the keystroke
combination you want to assign to that
function. Congratulations, you just set your
first hotkey for DeaDBeeF.

Also included is a builtin equalizer, allowing you to
tailor the sound output to your tastes.

When you run DeaDBeeF, it will
place an icon in your system
tray. It will display the current
song title when you hover the
mouse over the icon. You can
also control the volume level by
scrolling your mouse wheel
while your cursor is hovered
over the icon in the system tray.

The DeaDBeeF player will also support
automatic gain of playback volume, as
well as sporting an OSD mode. You
can find these items, as well as quite a
few other options, under the
Preferences menu.
What else can i say? Nothing, only that
I like it, and that ZipPlayer supports
DeaDBeeF Player. Try it out. I'm sure
you will like it, too.

DeaDBeeF: A Lightweight Linux Audio PlayerDeaDBeeF: A Lightweight Linux Audio Player

http://deadbeef.sourceforge.net/about.html
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Screenshot ShowcaseScreenshot Showcase
1. All the contents of the NEW PCLinuxOS Magazine are only

for general information and/or use. Such contents do not
constitute advice and should not be relied upon in making (or
refraining from making) any decision. Any specific advice or
replies to queries in any part of the magazine is/are the
person opinion of such experts/consultants/persons and are
not subscribed to by the NEW PCLinuxOS Magazine.

2. The information in the NEW PCLinuxOS Magazine is
provided on an "AS IS" basis, and all warranties, expressed
or implied of any kind, regarding any matter pertaining to any
information, advice or replies are disclaimed and excluded.

3. The NEW PCLinuxOS Magazine and its associates shall not
be liable, at any time, for damages (including, but not limited
to, without limitation, damages of any kind) arising in contract,
rot or otherwise, from the use of or inability to use the
magazine, or any of its contents, or from any action taken (or
refrained from being taken) as a result of using the magazine
or any such contents or for any failure of performance, error,
omission, interruption, deletion, defect, delay in operation or
transmission, computer virus, communications line failure,
theft or destruction or unauthorized access to, alteration of, or
use of information contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom the NEW
PCLinuxOS Magazine has no control or connection, business
or otherwise. These sites are external to the NEW
PCLinuxOS Magazine and by visiting these, you are doing so
of your own accord and assume all responsibility and liability
for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The NEW PCLinuxOS Magazine accepts no responsibility for
the content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Posted by Texstar, September 15, 2010, running KDE 4.
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by Paul Arnote (parnote)

In today's computer world, it might seem that
changing desktop wallpaper might be a rather
simple task. And, it is. But did you know that there
are multiple ways to manage your wallpapers and
panel decorations on PCLinuxOSLXDE?
Depending on how you choose to set it up,
wallpapers and panel decorations can remain
exclusive to each user, or they can be set up so that
all users have access.

Wallpaper Method One: All Users Access
First, you need to open up PCManFM in the
superuser mode, and move to
/usr/share/lxde/wallpapers.
Next, open up another instance of PCManFM as a
regular user. Move to the directory that contains the
wallpaper(s) you wish to add.
Drag and drop the wallpaper(s) you wish to add into
the /usr/share/lxde/wallpapers directory.
Right click on the file(s) you just added, and make
sure the permissions are properly set. Both the
owner and group should be set to "root."
Permissions for the owner should be read and write.
For group and other users, the permissions should
be set to read.
Close both copies of PCManFM.
Now, under the "Appearance" tab of LXDE Control
Center, select "Set Wallpaper." Alternatively, you can

right click on the desktop, and select "Configure
Desktop."
Your new wallpaper will now appear as a choice in
the selection window. Choose it, and close out of the
LXDE Control Center.
Advantage: All users will have your new wallpaper
as a choice for their desktop.
Disadvantage: If you add too many graphics, you
may start to crowd your root partition, which is
typically much smaller than your /home partition.
Requires root privileges to add/remove wallpaper
graphics.

Wallpaper Method Two: Local User Only

In your /home directory or partition, there is a hidden
directory called .local. Beneath that is another
directory, named share. Create a directory in the
$HOME/.local/share directory called wallpapers, if it
doesn't already exist.
Now, copy your selected wallpapers to the
$HOME/.local/share/wallpapers directory.
Go to the LXDE Control Center's "Set Wallpaper"
button (which, by the way, is the same as choosing
PCManFM's Edit » Preferences menu, then the
Desktop tab). Click on the folder icon to the right of
the selection box, then traverse to the
$HOME/.local/share/wallpapers directory. Select
your wallpaper, and click OK.
Alternatively, you can create an "Images" folder in
your /home directory, and within it, create folders
named "wallpapers" and "panel." Actually, you can
create any folder you want in your /home directory,
and use the steps above to display your wallpaper
on your desktop. The advantage to the "Images"
folder is that it helps keep you, and all of your
wallpapers and panel graphics, organized.
Advantages: doesn't take up unnecessary space in
your root directory (if your /home directory is on a
separate partition). Wallpapers can be added by the
end user, without the need for root privileges.
Disadvantages: wallpapers stored using this method
are not available to other users of the same
computer.

LXDE: Add Wallpapers, Panel DecorationsLXDE: Add Wallpapers, Panel Decorations
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Panel Decorations
You can also perform similar actions with your panel.
Just as easily as you can apply custom wallpaper to
your desktop, you can also dress up your panel with
custom graphics.

Right click on an empty spot on your panel, and
select "Panel Settings" from the context menu that
appears. Go to the "Appearance" tab, and you can
select the background appearance of your panel.
You can select from using the system theme, a solid
color with userselectable levels of opacity, and an
image.
In a default installation of PCLinuxOSLXDE, many
of the graphics used to display the panel are stored

in /usr/share/lxpanel/images. But just as we were
able to change to another location when we
changed our wallpaper, we can also change the
location where lxpanel looks for the background
images it uses. It's exactly the same procedure.

Conclusion
As you can see, it's very easy to customize the
appearance of your LXDE desktop. You can be as
creative as you like. It is, after all, Linux. Your Linux.
Your desktop. Your choice.

Screenshot ShowcaseScreenshot Showcase

Posted by nmark, September 25, 2010, running KDE 4.

LXDE: Add Wallpapers, Panel Decorations
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by Paul Arnote (parnote)

Mankind has forever been intrigued with the
weather. Crops are planted according to the
weather. Plant at the wrong time, and you risk wiping
out an entire crop. Outdoor events are planned with
regard to the weather. We get dressed in the
morning, according to the weather. The weather
permeates so many aspects of our lives, and has
done so since the dawn of civilization.
Even into the 21st Century, weather continues to be
a focal point in our lives. Enter Forecastfox
Weather 2.0, a Firefox addon that provides not only
the current weather conditions, but also a five day
forecast of expected weather conditions. Also,
Forecastfox Weather 2.0 will provide a live, on
demand animated weather radar for your registered
location. Forecastfox Weather will display the
weather information not only for the United States,
but also for international locations, as well.

A little history
Originally, I had planned on writing about
Forecastbar Enhanced 0.9. It contained all of the
features of Forecastfox Weather, plus a lot of extras,
including the live, ondemand animated radar image.
When I first went to the addon's download page,
you can imagine my horror when it prominently
stated that Forecastbar Enhanced 0.9 was no longer
being developed.
Forecastfox Weather originally debuted in
December, 2004, and was available for Firefox
versions 0.10 through 1.0+. It was originally named

Weatherfox. After 38 more subsequent releases, we
now are up to Forecastfox Weather 2.0.1. To date,
more than 21,000,000 users have downloaded the
vastly popular addon.
After a little further investigation, I discovered that
Aaron Sarna, the developer who added all the extra
features and whistles and bells to Forecastfox
Weather to create Forecastbar Enhanced 0.9, has
joined the Forecastfox Weather development team.
As a result, Forecastfox Weather 2.0.1 contains all
of those enhancements that were formerly in
Forecastbar Enhanced 0.9.

What you get

When you first install Forecastfox Weather 2.0, it will
add its display to your menu bar (at least it did on
my computer, and I cannot be certain if that is the
default position, or because that's where I had the
previous version of Forecastbar Enhanced appear).
You can move it with the gray icon that depicts a 4
way arrow (far left side of the data displayed). You
can choose to place it in your status bar, on the main
toolbar, on your tab bar, or on your bookmarks bar.
Basically, you should be able to place it wherever
find it most convenient to use.
By hovering your mouse over the green radar icon
will cause a popup window to be displayed,
complete with an animated radar image of your
registered area. The radar image, along with all of
the other weather data and forecasts, is supplied by
AccuWeather.com. Simply clicking the left mouse

button over any part of the Forecastfox Weather
addon will open the AccuWeather.com page for
your area, providing more indepth weather
information.
By clicking your right
mouse button over
the Forecastfox
Weather addon, you
will get the context
menu that provides
you several options.
From there, you can
give feedback to the
Forecastfox
developers for future
improvements, visit the Forecastfox home page, visit
the AccuWeather.com home pate, or recommend the
addon to your friends.

Firefox Add-ons: Rain or Shine, Forecastfox Tells AllFirefox Add-ons: Rain or Shine, Forecastfox Tells All
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You can also access information on how to
troubleshoot any problems you may be having in
getting Forecastfox set up. The "Reload Weather
Data" is useful if you have lost your network
connection for an extended period of time, or if you
want to update the weather information earlier than

the routine weather updates you have set. You can
also switch locations, since Forecastfox allows you
to monitor the weather at multiple locations. This is a
very handy feature if you are going on vacation, or if
you have family living in locations other than your
own.

When you select "Options" from the context menu, a
new tab will open in Firefox, and allows you to make
various settings related to how Forecastfox displays
the various weather data. You can choose the units
of measure to use, select from several different icon
sets to use when displaying your weather data,
whether or not to display severe weather alerts, the
size of the radar or satellite image to display (or
none at all), the number of days to include in the
forecast, and many other settings that dictate what
information to display, as well as how to display it.

Conclusion
For me, Forecastfox Weather is one of those "must
have" Firefox addons. I can't even begin to tell you
how many times I look at it during the course of the
day. There is also a version available for the Google
Chromium browser, although it lacks many of the
features of the Firefox version. But if you like to keep
track of current weather conditions, as well as keep
your eye on the weather forecast, you will fall in love
with Forecastfox Weather.

Firefox Addons: Rain or Shine, Forecastfox Tells All

http://pclinuxos.com/?page_id=188
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by Patrick G Horneker
There have always been applications for creating
and viewing eBooks (mostly in PDF and various
word processing formats). In recent years, a new
generation of devices specifically for reading e
Books entered the consumer market.
Among the most popular devices are the Amazon
Kindle and the Barnes and Noble Nook (the latter
now available at Best Buy), the subject of this article.
Yes, the Nook can be used with PCLinuxOS as a
USB mass storage device. What I am talking about
is Barnes and Noble’s software version of the Nook.
In addition to the WiFi and 3G enabled device,
Barnes and Noble has free downloadable
applications for Mac OSX and Windows, as well as
the popular iPhone, iPad, iTouch, Android, and
Blackberry. (Yes, Android is a Linux variant
designed for smart phones and other hand
held devices such as PanDigital’s Novel, now
available at Kohl’s.)
You’re probably wondering, where is the Linux
version? The bad news is there is no official
Linux version. The good news is the Windows
version actually runs on PCLinuxOS!
Prerequisites
Since the Nook is a Windows application, you
will need to make sure you have Wine
installed. (For those of you who do not know, wineis
a compatibility layer that allows Windows
applications to run on Linux.)

If you do not have Wine installed, open Synaptic,
then click on Search, type in wine, click on OK. wine
should appear in the package list. Double click on
“wine” to select that package and any of its
dependencies for installation. Click on Apply to
install wine on your PCLinuxOS system.
Also, you will need to be connected to the Internet to
install and use this application as the eBooks are
downloaded from the servers at Barnes and Noble.
Now, download the Nook application
When you surf to the Barnes and Noble homepage
(http://www.barnesandnoble.com), you will notice an
advertisement for the Nook prominently displayed at
the right side of the home page.
You can click on that to get to the applications page.
For PCLinuxOS, you will need to click on “NOOK for
PC”.

* Near the bottom
corner of the page you
should see the link to
download the installation
file. This is a Windows
executable file, and when
prompted by Firefox or
whatever browser you are
using, you should save
the file to the Downloads
directory rather than
opening it with File Roller
or some other archiver

that supports Windows executables.
* If you are using KDE, open Dolphin and then
select the Downloads folder. The Windows

executable should
be named
bndr2_setup_latest.
Right click on the
executable, then
select Open with...,
then select Wine
Windows Program
Loader to start the
installation of Nook.

If you are not using KDE, open a terminal, then type:
cd Downloads
wine bndr2_setup_latest.exe
to start the installation of Nook. Follow the
instructions given in the installation wizard. Nook
will install into ~/.wine/drive_c/Program
Files/Barnes & Noble/BNDesktopReader
and icons will be created for the KDE and GNOME
desktops. When the installation is finished, Nook
will automatically start (unless you uncheck the box
that tells the wizard to start Nook) and you should
see something like this:

Reading Barnes and Noble eBooks on PCLinuxOSReading Barnes and Noble eBooks on PCLinuxOS

http://www.barnesandnoble.com/u/free-nook-apps/379002321/
http://www.barnesandnoble.com


39

You can also start Nook for PC by selecting Wine >
Programs > Barnes & Noble > Nook for PC >
Nook for PC.
This initially appears as you will need to sign in to
download and access your books. If you do not
have an account at Barnes and Noble, you may
create a user account from this screen.
You can get to this screen at any time by clicking on
Settings, then selecting Account Settings.
Note: Though the application is called Nook for PC,
it really should be called Nook for PCLinuxOS as
this actually works here. :)

Once you have logged into the Barnes and Noble
servers, this is what should appear on the screen.
What you will find here are the most recently
published ebooks. Clicking on any of the Read
Now buttons will show you a sample of the contents
of the eBook you can purchase. For example,
clicking on the Read Now button under Bumppo
Bashing by Steven King will give you this: >

Of course, we should take a look at the User
Guide to Nook for PC.

Of course, to get these eBooks, you would have to
go to barnesandnoble.com to get these books.
Clicking on Shop will open Firefox to the page where
eBooks can be purchased for about $9.95 each for
most titles (top right).

The My Library tab is where you can see what is in
your library. eBooks are downloaded to
~/.wine/drive_c/Program Files/Barnes &
Noble/BNDesktopReader
For each item in the list, you can choose to read a
sample, download the eBook, move the book to
your archive, or show details about the book.

Reading Barnes and Noble eBooks on PCLinuxOS
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If you have downloaded a copy of the eBook, the
Download button will now say Remove Local Copy.
Clicking here will remove the local copy of the book
from your hard drive.
To log out of the servers, you will need to select
Settings > Account Settings and click on Logout to
close the connection to the Barnes and Noble
servers. After that you may close the application as
with any other window (usually with AltF4 or by
clicking on the close button).
About the eBooks
I went to the eBookstore, logged into my account
from Firefox, and then discovered that the books are
downloadable in the standard ePub format, so any
tools you may have that support the ePub format
can also be used to read eBooks purchased from
Barnes and Noble.
This means you can install and use Lucidor to read
eBooks, and Sigil to edit them. Both of these
applications are installable from
Synaptic. Open Synpatic, click
on Search, type epub and press
Enter to find these packages,
then select the packages and
click on Apply to install.
Lucidor can be launched from
the Office menu.
This is Dracula as rendered by
Lucidor. If Nook does not work
out, you can always use
download your eBooks from
any bookstore website such as

Barnes and Noble that you can download in ePub
format.

In this example, I am logged into the Barnes and
Noble eBook store where I can download the
Merriam Webster’s Pocket Dictionary in ePub
format. Unlike some places such as iTunes, once
you have purchased titles, you can download the

same file as many
times as you need to.
This is very useful if you
have to restore eBooks
for a replacement
reader, or if you
purchased a new e
book reader, or if you
wish to read eBooks
from your PCLinuxOS
machine. Think of this
as a restore from
backup plan for
eBooks.

Since this is Firefox, eBooks are downloaded to the
Downloads directory. On my laptop, I have eBooks
stored in Documents/Lucidor directory. Once I
download the books, I transfer the books from the
Downloads directory to the Documents/Lucidor
directory before opening them with Lucidor using
any file manager or a command line from a terminal
window. (Lucidor uses the Documents/Lucidor
directory by default.)
Sigil can be launched from the File Tools menu.
This is intended for publication of your own eBooks,
you can use this to open any book downloaded from
the store to see how the book was structured and
created. (Sigil will be used when I do an article on
creating and editing ePub files.)
Other eBook Readers
As I mentioned earlier, the Nook, Amazon Kindle
and Sony’s line of eReaders are USB mass storage
devices to PCLinuxOS. To store these eBooks, the
gadgets use internal flash memory (or depending on
the device, SD/MMC and Memory Stick cards as
well.)This means you can transfer ePub, PDF, and
ASCII text files to these devices for reading the
same way you would with a memory card reader or
a flash drive.
PanDigital has a eBook reader called the PanDigital
Novel (appropriately named) that uses the Barnes
and Noble servers for its eBooks. This is an
Android device (read that as a commercial product
running an embedded Linux kernel and running
applications written in Java) that is a much better
alternative to the iPad. The device operates off a
WiFi connection, with no provision for a 3G or 4G
connection.

Reading Barnes and Noble eBooks on PCLinuxOS
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The PanDigital Novel is available from any Kohl’s
department store, or you can order online here
(Kohls.com). Regular price is $259.99, but more
often than not, it can be purchased at a sale price.
I mention Kohl’s as it is the place to get this device
without having to order it online.
Amazon Kindle can be purchased locally at Target.
The Nook can be purchased locally at Best Buy, as
well as Barnes and Noble.
Viewing eBooks with Firefox
In addition to the gadgets and the EBook readers,
you can also view eBooks (in the ePub format) with
Firefox. Select Tools > AddOns from the Firefox
menu. Then the Addons dialog box appears, type
epub in the search box.

Here, the EPUBreader extension is highlighted as it
is the first item to appear in the search results. Click

on Add to Firefox... to install the ePub extension.
After installation, you will be prompted to restart
Firefox for the extension to be active.

After you restart Firefox, the above page should
appear in Firefox in a new tab. You may close the
tab to get rid of the message. Firefox is now ready
to display eBooks in the ePub format.
If you have this extension active, downloading books
from the Barnes and Noble account will cause the
books to be displayed in Firefox rather than
downloaded to your hard drive. To download
eBooks with EPUBreader active, hold down the
Shift key and click on Download to download the file
to the Downloads directory.

Reading Barnes and Noble eBooks on PCLinuxOS

Your Community Projects Forum

The NEW PCLinuxOS Magazine
Created with Scribus 1.3.7

http://pclinuxos.com/?page_id=215
http://pclinuxos.com/?page_id=213
http://www.tuxmachines.org
http://www.oneclicklinux.com
http://www.scribus.net
http://www.kohls.com/kohlsStore/electronicsgames/brandsforelectronics/pandigital/PRD~685112/Pandigital+Novel+eReader.jsp
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Are you brave
Are you bold
Come and have
Your fortune told

THE FOOL is innocent and
eager. We may seem
foolish as we start our
journey as a Linux user
with our pet Tux. Some
think we are lunatics. But
our hearts are open and
our minds are carefree as
we begin our adventure.

THE MAGICIAN keeps the
tools of the trade. He is the
Root Master ready to
instruct us in the ways of
Linux. The Magician is very
powerful and can bend us
to his will. Tread carefully
in his presence and be in
awe of his potential. Call
upon him with forethought

and caution.

THE HIGH PRIESTESS
controls that inner
energizing force of intuition,
revelation and inspiration.
She is passive and wise.
Use her force to quietly
observe and watch before
pressing ENTER.

THE EMPRESS gives us
that warm fuzzy feeling we
get when we look into the
Panel Tool Box and see the
abundance of widgets. She
is like a generous mother
offering us tasty cashews
and applets.

THE EMPEROR rules the
physical world. He uses his
will and logic to build a
Linux Empire. His creative
energy sustains us. He
exerts a benign and strong
influence over all who
come to his realm. He is a
STAR, a father figure and
wielder of authority.

THE HIEROPHANT gives
us the traditions of the
Linux culture. He teaches
us the ancient mysteries of
the console and watches
over the code. He urges
us to put it into our daily
routine and warns us not to
misplace those spaces.

THE LOVERS card is all
about choices. As new
Linux users we must
decide if we want to sit on
the Window sill or soar to
new heights. Do we want
the stagnation of the old or
the excitement and
challenge of the new.

THE CHARIOT is pulled by
Dobie the bull. We are off
with confidence to all the
applications. We love to
configure desktops. We
are pulled this way and
that. Enjoy this triumphant
journey but take time to
master the elements.

Forum Foibles: Linux Tarot CardsForum Foibles: Linux Tarot Cards
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STRENGTH gives us
patience and tolerance.
After the wild ride in the
Chariot, the Fool is
confronted with conflict and
new challenges. Mistakes
are made. Strength is
needed to keep going
despite setbacks.

THE HERMIT advises us
to step away and calmly
reflect. The HERMIT looks
for deeper truths. Seek out
a guide or teacher who can
give you advice or look for
those who might need your
insight and direction.

THE WHEEL of
FORTUNE means that
Linux is on the move. Roll
with the good times. Feel
the power. There may be
ups and downs but you are
in control. Don't forget to
do that updating. The
choice is yours.

JUSTICE is not about
punishment. It is about
adjustment. Do what is
necessary to have a great
Linux experience. An OS
should fit your needs and
not the other way around.
Make it accountable to you.

THE HANGED MAN
indicates you might be
hung up on some of the
commands. You know what
you want to do but can't get
to the root of the problem.
Calm down, be still, quit
struggling. You'll get the
hang of it.

DEATH brings transition.
You reformatted the wrong
partition. You lost data. You
forgot your password. You
are definitely due for a
change. Death is an "in
your face" reminder that
something new needs to
happen.

TEMPERANCE tells us to
go with the flow. Find the
right mix to get the most
out of your Linux system.
Try some new applications.
Balance your computer
use with fun and business.
Look for enlightenment.

THE DEVIL reminds you
that you might be ignorant
about your OS. Get out the
MANual and look for the
light. The konsole may
scare you like the devil but
get rid of that negative
attitude. You will make
errors but hold fast to that
high vision of yourself.

THE TOWER can mean
sudden disaster. Maybe a
crumb in the keyboard,
dust in the tower or a
crinkle in a cord. The
disruption can be a
learning experience if time
is taken to understand the
why. Put things back
together and change a few
routines.

Forum Foibles: Linux Tarot Cards
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THE STAR brings harmony
and balance and an
emotional Linux high. Now
is the time to inspire
others. Show your positive
side and your star qualities.
Volunteer your time in the
forum.

THE MOON stimulates our
imagination. You may feel
a bit lost and bewildered or
have an attack of the
plasmoids. Time to get
mental clarity. Read a few
tuts and stop your whining.

THE SUN gives you total
confidence. With
PCLinuxOS you can
achieve all you want. It
gives you energy and
vitality. Boot it up. Feel the
potential. Set an example
and share your success
with others.

JUDGMENT encourages
us to look for new
opportunities. Assess
accomplishments and work
toward improving Linux
skills. Try a remaster. Help
with packaging. Contribute
to your favorite distro.

THE WORLD heralds
fulfillment and triumph. It
also signifies new Linux
friendships. By joining the
PCLinuxOS forum you
have met users from
around the world who have
the same goals and
ambitions. Well done!

When the daemon is in the seventh shell
And grub aligns with root

Then peace will guide the bios and man will steer the boot

This is the dawning of the Age of Linuxius
The Age of Linuxius Linuxius Linuxius

Logging in you'll find so easing GUI so very pleasing
A bit of bashing and some swapping but no more distro hopping

Mystic mounting and formatting no virus for combatting
Linuxius Linuxius

Let PCLOS shine Let PCLOS shine PCLOS shine

MP3 OGG

Forum Foibles: Linux Tarot Cards

http://pclosmag.com/html/Issues/201010/files/ageoflinuxius.mp3
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by Gary L. Ratliff Sr. (eronstuc)
The language Pascal was developed by Niklaus
Wirth. He has already been mentioned as
developing other languages, Modula 2 and Oberon
2. Were this not enough, he was also instrumental in
developing the language ALGOL. However, there
was quite a bit of difficulty in developing compilers
for it, so it remained a language to formally state the
algorithms for solving various computer problems,
instead of a language used to develop software.
However, I remember that a system for ALGOL was
available back when I was using a Kaypro and
CP/M. Here it was possible to purchase, for very low
fees, libraries from Sound Potential and other
companies. Also, using NZ and the Z systems, it
was possible to run the applications from a system
in which the files were compressed on the hard drive
and only expanded when the file was run. While
serving as moderator on the CP/M group of the
Intelec Network, one of the great debates was that
Borland denied writing a Turbo Pascal for the CP/M
operating system. So I loaded my CP/M CDROM
from Walnut Creek and performed a search on
ALGOL and Pascal, which verified that there was a
version or two of ALGOL available for this system,
and yes, there were many many systems developed
for CP/M using Turbo Pascal.
Now Wirth was writing the specifications for the
language Pascal at about the same time I was
taking my first computer language course in Fortran
at Delta State. The language was introduced to the
computer world the same year I got married and
earned my BBA degree, and the language was
introduced by Wirth in 1971. It was easy to learn and
was used mainly as a device to teach students to

program. The back cover of one of the text books I
used in researching this article: Introduction to
Pascal and Structured Design, Second Edition by
Nell Dale and Chip Weems © 1987 D. C. Heath and
Company states that: “Over a quarter of a million
students have been introduced to problem solving
and good programming techniques with the first
edition of Pascal.”
Wirth received the A. M. Turing Award in 1984 “for
developing a sequence of innovative computer
languages: EULER, ALGOLW, MODULA, and
PASCAL.” The Turing award has been awarded
annually since 1966, and is the “highest distinction in
Computer Science the Nobel Prize in computing.”
Since 2007 this award has been accompanied by
$250,000 cash provided by cosponsors Intel and
Google. Other persons who have received this
award who have also been mentioned in this series
were John Backus, who won in 1977 for Fortran,
and Ken Iverson, who won in 1979 for APL.
Getting a Compiler and Other Tools
The PCLinuxOS repository has several tools which
will enable you to compile and develop software in
the Pascal language. Also, many of the tutorials
mentioned will have links to enable you to download
compilers for Pascal and other development tools for
this language. Many of these will be specifically for
Windows. However, my stance on the matter is that
there is a good chance that your computer also has
Windows installed (or you have access to a
computer running Windows), so why not go ahead
and use this part of your computer to develop your
programming skills and knowledge.
The tools will be obtained using the synaptic

package manager. As always, you will become root
to perform the install task.
The systems we will be installing from the
repositories are: FPC (the Free Pascal Compiler),
Lazarus (a graphic IDE for developing Free Pascal
code), and the gtk editor scite. This editor is useful
for its ability to correctly indent and color code the
syntax of a Pascal program as it is entered. It is not
only this language for which this editor provides
these services, but also a vast assortment of many
computer languages and shell programming
languages.
Forum member and magazine staff member Patrick
Horneker adds that if you have a version of DOS
running inside VirtualBox or QEMU, you can use that
as well. On his laptop, he has an old copy of Turbo
Pascal that he obtained when he took a course in
Pascal in his college days. Free Pascal is somewhat
compatible with Turbo Pascal, if you do not
implement any libraries with Turbo Pascal's UNIT
concept, nor use any low level extensions such as
the DOS specific interrupt functions. Also, Borland's
Delphi is a Turbo Pascal variant designed for
database development. Free Pascal is somewhat
compatible with Delphi. Patrick knows this, since his
first on the job experience with programming was
with Turbo Pascal.
Tutorials: We have Tutorials
There are a vast number of tutorials available, and
they may be found by entering Pascal Tutorial into
the search window of your Firefox browser. So we
will just present an array of snapshots taken from
the web pages of some of the best tutorials found:

Programming Languages A to Z: PascalProgramming Languages A to Z: Pascal
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The above page shows links to several
tutorials, which aid one in programming with
the pascal language. The version of the
language which is regarded as the king of the
hill is the Borland Turbo Pascal compiler. This
is the one which the Free Pascal Compiler
tries to closely adhere to.

This page as stated is devoted to teaching you
programming using Borland Turbo Pascal. It
offers to download the most recent version,
which Borland has made freeware. However,

this is a zip file and will
download to your Download
folder in My Documents
under Windows. This is not
where the install.exe
program will want to use it.
So first, move it to the root
directory and let the install
create the TP directory. It
would be run by opening a
command prompt in
Windows, and then
changing to the root
directory and then to TP.

This page (above) shows that it covers Free
Pascal, Turbo Pascal and Pascalite. I was able
to download this but later attempts to further
study this site only produced the Error 404 for
site not found.

Programming Languages A to Z: Pascal
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This has been found to
be an excellent tutorial.
It assumes no prior
knowledge of
programming and is
very easy to follow.
As you can plainly see,
there is an abundance
of sources for you to
learn the language.
Now we have the Free
Pascal Compiler on our
system. The following is
an example of code
from the text I used,
along with some praise

for the folks at freepascal.org. The book I was
using was written before some rather large
changes were made. So as long as I did not
try to use text files, these would compile, or
they would show me my typos and I would try
again. But even with the program typed in
perfectly, the program would compile but
report an error 102 when run. So I emailed my
problem to michael@freepascal.org and had a
reply with the remedy within hours.
The files used as text first required an Assign
and then also needed to be closed before the
program finished. Here is an example (below
right), which was saved in the scite editor to
also show the indentation and color coding of
the Pascal syntax.

So now, with these corrections supplied by Michael
Van Canneyt, the program compiled and the data
was stored in the file outmpg for reading, via the
command less outmpg. This indicated that the folks
at the free pascal site are very helpful. Also, by
visiting their site, you can download full
documentation for the Free Pascal compiler in pdf
format. Simply click on the documentation link.
Some folks think that Pascal has become obsolete.
However, Michael assured me in his email that he
uses it to create games, databases and other major
projects, and that it is alive and well. It has also
added some object orientated features. I hope this
will encourage you to try to add Pascal programming
to your arsenal.

Programming Languages A to Z: Pascal
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Pascal and Structured Programming
(added by Patrick G Horneker)
Pascal has always been a language for teaching of
structured programming and other good
programming practices. One of the first things that
Pascal forces programmers to do is to think about
the design of the program, specifically that the
program should be designed from the top down, with
the top being the primary objective of what the
program is to accomplish. Once that program is
broken down into steps, you then break those steps
into smaller steps, until you get to the minute details.
Programs in Standard (ISO) Pascal have only one
entrance and one exit. This concept is true whether
you are implementing the main portion of the
program, or a subroutine to access a file on a disk.
One advantage to using Pascal for applications is
that a topdown design and a concept of structured
programming results in software that is reliable and
quality controlled.
If you used only ISO Pascal for your DOS
applications, chances are that your applications can
be ported to PCLinuxOS with a minimum of work
(depending on whether you are using a textmode
application, or are using bindings for Gtk, Qt, or
some other graphical interface toolkit.) Windows
applications in this language, however, will require
some work, specifically rewriting subroutines that
call Windows specific functions to subroutines that
call functions for X, Gtk, Qt, or whatever graphical
toolkits are available for FreePascal.

Screenshot ShowcaseScreenshot Showcase

Programming Languages A to Z: Pascal

Posted by MerReady, September 4, 2010, running Gnome.
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by rvndmnmt

I guess I should begin with intro.
Hi. My name is Larry and I'm an alcho....er....wrong
meeting.
I've been part of the Linux community since about
'97. Back then, Xwindows were new. Amongst a
whole lot of other goodies that people take for
granted now. I kind of gravitated away from Linux
back in '04, because it made no sense to have such
a wonderful operating system
with a wonderful GUI that
required alot of time at the
command line to interface
with. In short, Linux was an
interesting toy. I could surf
the net with it, maybe even
listen to a few MP3's. There
was a definite performance
advantage over Windows
95/98/SE. But actual usablity,
short of a server, was a little
harder to attain. I couldn't
see the OS going any place
in the state that it was in.
Well. I recently tried to get a
job in the IT field. This is
something I have been doing for some time, butfoun
d out that paper and letters behind the name seem
to count for a lot in these days. I went back to
school and have/had a few classes in Linux. I
figured that with my previous exposure, it would be a
cinch. I also figured that not much has changed.
Boy, was I wrong.

Back when I got into Linux, the main things going
were RedHat, SuSE, Mandrake, Debian, and
Slackware to name a few. I had experience in every
one of those flavors, including Slackware on a
masochistic trip into madness.
I mean seriously, the CLI is a powerful tool, but with
as powerful as computers are these days, a GUI
wasn't as much as a performance hit as it was, lets
say, in 98. And Linux, while functional, wasn't totally
functional as an operating system.
Ubuntu was my first descent back into this madness.

Nothing wrong with that OS.
Actually very usable. I loaded it
onto my sisters computer (read
zero computer experience), and
she uses it to this day two years
later. I used to use it a lot
myself, until 10.04. I still use it
on my PS3 (interesting, but not
recommended). But, I have
tried out other flavors as well.
Fedora was a requirement for
school, however I don't like
SELinux and configuration is a
pain when you have to
configure the OS through
/etc/pam.d/ to even access the
root account in graphical mode.
Not that SELinux is

complicated, I just get a little leery when the NSA
writes security software is all. That, and it reminds
me to much of User Access Control in Windows
Vista/7.

For the record Microsoft really overdid themselves
with 7, even though it is just a slimmed down version
of Vista.
So it comes into now. I ran into PCLinuxOS by
accident. I was actually pretty pleased with the
result. Currently, I have it operating on a 1.8GHz
Pentium 4 and a 2000 AMD XPM at work. I also
have it running on my Core2Duo for school (no
hardware virtualization allowed on the CPU, and it
performs as good or better in X32 mode than X64
mode). I also have it set up in dual boot mode on my
latest build (Phenom2 6 core, 8 gig of ram,
Crossfired ATI video cards, ect). About the only thing
it cant do is play the games I need Windows for.
About the only thing I could ask for is a 64bit version
of PCLinuxOS. But I guess that is going to be a
while.
Anyways, just thought I would say hi. And a sincere
thanks to the developers of PCLinuxOS, since it has
most of what I would ever want in a Linux OS.

Testimonial: Arriving To PCLinuxOS By AccidentTestimonial: Arriving To PCLinuxOS By Accident
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http://www.pclinuxonline.com
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(sung to “Big Yellow Taxi”, original lyrics by
Joni Mitchell)
parody lyrics by Patrick G Horneker

They fixed my laptop
with PCLinuxOS
With a LiveCD, a hard drive
and a Wifi Hot Spot
Don’t these people seem to know
that Linux has
what you want
and it works
They fixed my laptop
with PCLinuxOS

Buy a new laptop,
install a copy of Windows 7
Microsoft charges people
200 dollars for the upgrade
Don’t these people seem to know
that Linux has
what you want
and it works
They fixed my laptop
with PCLinuxOS

Hey Ballmer, Ballmer
put down that big old chair now
Give me CUPS for my printers,
leave me the Wine and Firefox, please
Don’t these people seem to know
that Linux has
what you want
and it works
They fixed my laptop
with PCLinuxOS

Late last night,
I heard the hard drive crash
and the big Linux laptop
erased all of Windows
Don’t these people seem to know
that Linux has
what you want
and it works
They fixed my laptop
with PCLinuxOS

Big Linux LaptopBig Linux Laptop
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Top left: Posted by pirate, September
12, 2010, running KDE 4.

Top right: Posted by coffeetime,
September 8, 2010, running LXDE.

Bottom left: Posted by Maik3531,
September 25, 2010, running Gnome.

Bottom right: Posted by omskates,
September 3, 2010, running KDE 4.
Want to see your screen shot featured
in the magazine? Post it to the Monthly
Screenshot thread in the forum!
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